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Übung Nr. 1: Curvetracer für BJT (1_Curvetracer_wrk) 

Es sind drei Schaltungen zur Simulation und Darstellung der drei Kennlinien 

C BE CE

C B CE

C CE B

A) I f(U ) mit U 12V

B) I f(I )mit U 12V

und

C) I f(U ) mit I 0, 10, 20, ... 100uA

= =
= =

= =

 

des Transistors BC547B aufzubauen. 

Step by Step: 

C BE CEA) I f(U ) mit U 12V= =  

a) Erstellen Sie in Ihrem Directory „ADS“ ein neues Workspace mit mit dem Namen 
1_Curvetracer_wrk und der Library mit dem Namen IcvsUbe_lib 
(Student Quick Reference Guide, Part 1, S5) 
 

 

b)  
 Erstellen Sie in der Library IcvsUbe in einer neuen Cell mit dem Namen IcvsUbe ein 

Schema mit dem Namen schematic_IcvsUbe 
(Student Quick Reference Guide, Part 1, S9) 
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 Zeichnen Sie im „Schematic View“ die Messchaltung, fügen Sie eine DC-Simulation, die 
Variablendeklaration und komentierenden Text hinzu.  

 Definieren Sie alle Parameter und Variablen gemäss Beispiel. 

2

3

44

5
7

6

 

1) Verwenden Sie den Transistor BC547B. Sein nichtlineares Modell ist in der 
mitgelieferten Vendor Component Library Analog_Parts. Fügen Sie diese Library dem 
Workspace hinzu.  
(Student Quick Reference Guide, Part 1, S12) 
 

 

2) Component > Component Library ...     oder   
 
BC547B in Schema einfügen 
Komponenten-Text verschieben:   
Edit > Component > Move Component Text   oder  F5 
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3) Component Palette List  „Probe Components“ 
 
Benennen Sie das Amperemeter (I_Probe) mit dem Elementnamen Ic. Dies vereinfacht 
in der Datendarstellung die Auswahl und Bezeichnung des Kollektorstromes. Achten 
Sie auf die Stromrichtung (ev. Spiegeln um y-Achse). 

4) Component Palette List  „Sources-FreqDomain“ oder „Sources-TimeDomain“ 
 
Definieren Sie alle Parameter und Variablen gemäss Beispiel. 
 
Component Parameter editieren: Direkt auf Schema oder Doppleklick auf Element 

5) Component Palette List  „Data Items“  oder   

6) Component Palette List  „Simulation-DC“ 

7) Beschreibender Text:   

Da Text in Schemas häufig verwendet wird, fügen Sie einen Button  in der Toolbar 
ein: Tools > Hot Key/Toolbar Configuration… 

 

 Speichern Sie das Schema  .  
Nicht gespeicherte Views weisen in der Kopfzeile einen Stern auf. 
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 Simulation starten      oder F7 

c) Neues Daten Dispay öffnen    
(je nach Defaulteinstellung wird nach der Simulation automatisch ein Daten Display geöffnet)  

 Rectangular Plot einfügen (Student Quick Reference Guide, Part 1, S19)     
Als Trace Ic auswählen. Für die unabhängige Variable (x-Achse) wird automatisch Ube 
gewählt, da dies der Sweep-Parameter in der Simulation ist. 

 Data Display formatieren, beschriften, etc. 

0.2 0.4 0.6 0.80.0 1.0

50

100

150

200

0

250

Ube

Ic
.i,

 m
A

Ic versus Ube  @ Uce = 12 V

 

 
 
 
Ströme werden im 
Dataset immer mit 
„Variablenname.i“ 
bezeichnet. 

 

 Data Display speichern   
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C B CEB) I f(I )mit U 12V= =  

 Erstellen Sie eine neue Library mit dem Namen IcvsIb_lib: (Main) File > New > Library 

 Erstellen Sie in der Library IcvsUbe in einer neuen Cell mit dem Namen IcvsIb ein 
Schema mit dem Namen schematic_IcvsIb 
(Student Quick Reference Guide, Part 1, S9) 
 

  

 Erstellen Sie das Schema mit allen Angaben. Dies geschieht am einfachsten, wenn Sie 
im Schema IcvsUbe alles markieren, in den Buffer kopieren (Ctrl-C), im neuen Schema 
einfügen (Ctrl-V) und hier die entsprechenden Änderungen vornehmen. 

   

 Simulieren, neues Daten Display erstellen, abspeichern  
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C CE BC) I f(U ) mit I 0, 10, 20, ... 100uA= =  

 Erstellen Sie eine neue Library mit dem Namen IcvsUce_lib: (Main) File > New > Library 

 Erstellen Sie in der Library IcvsUbe in einer neuen Cell mit dem Namen IcvsUce ein 
Schema mit dem Namen schematic_IcvsUce 

 Erstellen Sie das Schema mit allen Angaben.  
 
Hier wird für den Basisstrom ein Parameter-Sweep aufgesetzt. Für jeden im Parameter-
Sweep definierten Step wird die DC-Analyse durchgeführt und die Resultate ins Dataset 
geschrieben. Es entsteht somit ein mehrdimensionales Dataset. 
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 Simulieren, neues Daten Display erstellen, speichern  
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Übung Nr. 2: NF-Kleinsignalverstärker (2_AF_Amp_wrk) 

Es sind verschiedene Simulation und Darstellung der Simulationsresultate am Beispiel eines NF-
Kleinsignalverstärkers vorzunehmen: 

1. DC-Arbeitspunktanalyse 

2. Optimierung der Basisspannungsteilerwiderstände für gegebenen DC-Arbeitspunkt 

3. AC-Kleinsignalanalyse mit Darstellung des Bodediagramms 

4. Optimierung der Gegenkopplung auf gewünschte Verstärkung 

5. Simulation der Nichtlinearitäten mit Harmonic-Balance 

5.1. Eintonaussteuerung 

5.2. Zweitonaussteuerung 

6. Transientensimulation 

Workspace-Hierarchie: 
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1. DC-Arbeitspunktanalyse 
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2. Optimierung der Basisspannungsteilerwiderstände für gewünschten DC-Arbeitspunkt 

Im Basisspannungsteiler soll Rb so verändert werden, dass ein Kollektorstrom vom 5 mA 
resultiert. 

Siehe auch „Student Quick Reference Guide, Part 1, 6. ADS Optimization Cockpit“. 
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3. AC-Kleinsignalanalyse mit Darstellung des Bodediagramms 

Wir erstellen das Schema des Verstärkers und das zugehörige Symbol (Subcircuit) in einer Library 
„AF_Amp_lib“ und alle Simulationsschaltungen in einer Library „TestBenches_lib“. 

 

„schematic“: 
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 „symbol_AF_Amp“: 

 

„schematic_ACAna“: 

 

Es gibt drei Möglichkeiten um die Verstärkung (oder andere zu berechnende Grössen) im Datadisplay 
darzustellen: 

• MeasEqn auf dem Schema 
• Eqn im Datadisplay 
• Berechnung direkt im Diagramm 
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4. Optimierung der Gegenkopplung auf gewünschte Verstärkung 
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5. Simulation der Nichtlinearitäten mit Harmonic-Balance 

5.1. Eintonaussteuerung 

 

 

 



BFH TI EKT ADS2012 (Advanced Design System, Agilent-EESof) Übungen 

02.2013 F. Dellsperger 17 

 

 



BFH TI EKT ADS2012 (Advanced Design System, Agilent-EESof) Übungen 

02.2013 F. Dellsperger 18 

Anmerkung zum Inhalt des Dataset und die Verwendung der Daten: 

Das Dataset das durch die Simulation erzeugt wird, enthält die Datenwerte der Variablen. Der Aufbau 
des Datenset und die Verwendung der Daten wird an obigem Beispiel erläutert: 

Inhalt und Aufbau des Dataset können abgefragt werden: 

 

Sollen im Diagramm oder in Gleichungen (Eqn) nicht alle Variablenwerte verwendet werden, kann der 
Bereich der Datenwerte mit folgender Syntax eingeschränkt werden: 

Variablenname[Index_Variable1,Index_Variable2]   
Beispiel oben mit 2-dimensionalem Dataset. Angaben für mehrdimensionale Dataset entsprechend 
erweitern. 

Index kann ein einzelner Datenpunktindex, oder ein Bereich, oder alle Datenpunktindexe sein. 

Beispiele zu obiger Simulation: 

Uout[1,7] Uout für den 1. Uin-Wert und die 7. Harmonische  
  (die 0. Harmonische mit Index 0 ist der DC-Wert) 

Uout[5,::] Uout für den 5. Uin-Wert und alle Harmonischen 

Uout[::,2::11] Uout für alle Uin-Werte und die Harmonischen 2 bis 11 

Uout[1::2::31,::] Uout für die Uin-Werte 1,3,5,…31 (Start::Schritt::Stop) und alle Harmonischen 

Eqn Nenner=sum(HB_1Tone_THD..Uout[::,1::10]**2)
entspricht 

 Summe aller Uout2  für alle Uin und die Harmonischen 1 bis 10. 
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5.2. Zweitonaussteuerung 
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6. Transienten-Simulation  
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Übung Nr. 3: S-Parameter- und EM-Simulation, Tiefpassfilter 
(3_MS_LP_wrk) 

Die S-Parameter-Simulation eignet sich nur für die Analyse linearer Schaltungen und erfolgt im 
Frequenzbereich. Sie ist die schnellste Analyse überhaupt. Es stehen sämtliche physikalischen 
Elemente (Leitungen, Microsripline, Stripline, gemessene Herstellerdaten von Widerständen, 
Kapazitäten, Induktivitäten, Transistoren, Dioden, etc.) zur Verfügung.  

Die vielfältigen Möglichkeiten dieser Simulation wird anhand der Entwicklung eines Tiefpass-Filters in 
planarer Technik (Microstripline) gezeigt. 

Die Spezifikationen des Filters sind gegeben durch: 

Filtercharakteristik: Chebishev 

Ordnungszahl  n : 5 

Welligkeit im Durchlassbereich (Ripple)    ra : 0.05 dB 

  entsprechend einer minimalen Rückflussdämpfung von 19 dB 

Grenzfrequenz   cf : 1000 MHz 

Quellen- und Lastimpedanz  oZ : 50 Ω 

1. Filterelement parallel  

Planartechnik Microstrip 

Substrat RO4350B, 60 mil 

Der Designablauf kann in 7 Schritten gemäss Flussdiagramm auf der nächsten Seite erfolgen. 

Step 1: Filterspezifikation (Pflichtenheft), siehe oben. 

Step 2: Exakte Synthese der idealen, konzentrierten Elemente (L, C) 

Für den normierten Tiefpass ( 0R ' 1 ' 1= =Ω Ω ) erhalten wir durch Berechnung oder aus 

einem Filterkatalog die normierten Elementwerte: 

0 6 1 5 2 4 3g g 1 g g 0.9984 g g 1.3745 g 1.8283= = = = = = =  

0R ' 1 Ω=

1 1C' g F=

2 2L ' g H=

3 3C' g F=

4 4L ' g H=

5 5C ' g F=
6 6R ' g= Ω

 

Mit der Entnormierung auf 0R 50= Ω  und c c2 f 2 1000 MHzω = π = π ⋅  erhält man die Elementwerte: 

0 0 0
0 6 0 1 5 1 3 3

0 0 c 0 c

Z R ' R '' '
R R g 50 C C g 3.178 pF C g 5.8197 pF

R' Z Z

        Ω Ω= = = Ω = = = = =        ω ω        

0
2 4 2

0 c

Z '
L L g 10.9379 nH

R'

   Ω= = =   ω   
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Designablauf für passive, planare Filter: 

Spezifikationen

Specs OK

Konzentrierte, 
ideale Elemente:
Exakte Synthese

Konzentrierte Elemente ersetzen
durch ideale,  verteilte Elemente 

(ohne Diskontinuitäten, 
ohne Verluste)

Specs OK Optimierung

Diskontinuitäten  
einfügen

Specs OK Optimierung

Layout mit 
Anschlussleitungen

EM-Simulation

Specs OK
Optimierung 

(meist nicht nötig)

Fabrikation

N

J

N

J

N

J

N

J

1.

2.

3.

4.

6.

7.

Verluste einfügen

Specs OK
Optimierung 

(meist nicht nötig)
N

J

5.
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Step 3: Konzentrierte Elemente ersetzen durch ideale, verteilte Elemente 
 
In diesem Beispiel: 
 
  - verlustlose Microstriplines ohne Discontinuitäten 
 
  - die Parallel-C’s werden ersetzt durch niederohmige Microstrip- 
     Leitungen (Leiterbreite = 12 mm). 
     Niederohmige Leitungen (grosse Leiterbreite) haben ein grosses  
     Parallel-C und ein kleines Serie-L.  
     Das umgekehrte gilt für hochohmige (kleine Leiterbreite) Leitungen. 
 
  - die Serie-L’s werden durch hochohmige Microstrip-Leitungen ersetzt  
     (Leiterbreite = 0.3 mm) 
 
 

Mit folgenden Approximationen werden die ungefähren Leitungslängen bestimmt: 

Zb Zc ZdZa

bZ = ∞aZ dZ = ∞cZ
cZ 0=bZ

C1 C3
L2

l2mech
l1mech l3mech

Term
Term2

Z=50 Ohm
Num=2

Term
Term1

Z=50 Ohm
Num=1

L
L4
L=10.9379 nH

L
L2
L=10.9379 nH C

C3
C=5.8197 pF

C
C5
C=3.178 pF

C
C1
C=3.178 pF

 

Für hohe Frequenzen gilt: bZ → ∞ . Damit kann man approximieren: 
c

b f f
Z

=
≈ ∞  (Leerlauf) 

Dadurch kann C1 durch ein am Ende leerlaufendes Leitungsstück ersetzt werden und es gilt: 

1el
a 01

c 1

2 l 1
Z jZ cot

j C

π = − = λ ω 
 

Dabei ist: 

01Z =  Leitungsimpedanz der ersten Leitung 

1ell =  elektrische Länge der ersten Leitung 

λ =  Wellenlänge bei cf  

c c2 fω = π  
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Die Auflösung nach ell  ergibt: 

( )1el c 1 01l a tan C Z
2

λ= ω
π

 

Die mechanische Leitungslänge erhält man mit: 

1el
1mech

e01

l
l =

ε
 

Da die beiden Grössen 01Z  und 01ε  von der Leiterbreite und dem Substrat abhängig sind, 

müssen sie zuerst bestimmt werden. Mit Hilfe des in ADS integrierten Werkzeuges „Linecalc“ 
können diese Grössen bestimmt werden. Für das gegebene Substrat und die vorgegebene 
Leiterbreite erhält man: 

01Z 20.1= Ω  e01 3.047ε =  

 

 

Für hohe Frequenzen gilt: cZ 0→ . Damit kann man approximieren: 
c

c f f
Z 0

=
≈  (Kurzschluss) 

Dadurch kann L2 durch ein am Ende kurzgeschlossenes Leitungsstück ersetzt werden und es 
gilt: 

 

2el
b 02 c 2

2 l
Z jZ tan j L

π = = ω λ 
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c 2
2el

02

L
l a tan

2 Z

 ωλ=  π  
 

2el
2mech

e02

l
l =

ε
 

Für das gegebene Substrat und die gegebene Leiterbreite erhält man: 

02Z 137= Ω  e02 2.367ε =  

 

Auf gleiche Art kann auch C3 berechnet werden. Da C1 = C5 und L2 = L4, sind auch die 
entsprechenden Microstrip-Leitungen gleich.  

Hier die vollständige Berechnung: 

fc 1 103× MHz⋅= λ
3 108⋅

fc
:= ωc 2 π⋅ fc⋅:=

Ideale Elementwerte
aus Synthese

Mikrostrip-Eigenschaften aus Linecalc 
(RO4350B, w1=w3=w5=12 mm, w2=w4=0.3 mm

C1 3.178 pF⋅= Z01 20.1 Ω⋅:= εe01 3.047:=

L2 10.938 nH⋅= Z02 137 Ω⋅:= εe02 2.367:=

C3 5.82 pF⋅= Z03 Z01:= εe03 εe01:=
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L4 L2:= Z04 Z02:= εe04 εe02:=

C5 C1:= Z05 Z01:= εe05 εe01:=

l1
λ

2 π⋅
atan ωc C1⋅ Z01⋅( )⋅ 18.224 mm⋅=:= l1mech l1

1

εe01
⋅ 10.44 mm⋅=:=

l2
λ

2 π⋅
atan

ωc L2⋅

Z02









⋅ 22.2 mm⋅=:= l2mech l2
1

εe02
⋅ 14.43 mm⋅=:=

l3
λ

2 π⋅
atan ωc C3⋅ Z03⋅( )⋅ 30.263 mm⋅=:= l3mech l3

1

εe03
⋅ 17.337 mm⋅=:=

 

Anschlussleitung
W aus "Linecalc"

50 OhmC5L4C3L2C150 Ohm

verlustfrei

Startwerte aus
Approximation

Eingefuegter Test: Layer von "ads_device:drawing" auf
"ads_device:ads_drawing3" geaendert, damit er in
roter Farbe erscheint. (Properties aendern).

Var
Eqn

S-PARAMETERS

MSub

MSUB

VAR

MLINMLIN

S_Param

Term Term

MLINMLIN MLIN MLINMLIN

RO4350

VAR1

TL7TL6

SP1

Term1 Term2

TL2TL1 TL3 TL5TL4

Rough=0 um
TanD=0
T=35 um
Hu=1.0e+033 mm
Cond=1.0E+50
Mur=1
Er=3.66
H=60 mil

L3=17.34
L2=14.43
L1=10.44

L=10.0 mm
W=3.4 mm
Subst="RO4350"

L=L1 mm
W=12.0 mm
Subst="RO4350"

L=L2 mm
W=0.3 mm
Subst="RO4350"

Step=2 MHz
Stop=6 GHz
Start=10 MHz

Z=50 Ohm
Num=1

Z=50 Ohm
Num=2

Subst="RO4350"
W=12.0 mmW=3.4 mm

L=10.0 mm

Subst="RO4350" Subst="RO4350"
W=0.3 mm
L=L2 mmL=L1 mm L=L3 mm

W=12.0 mm
Subst="RO4350"

 

1 2 3 4 50 6

-80

-60

-40

-20

-100

0

freq, GHz

dB
(S

(2
,1

))
dB

(S
21

_l
um

pe
d)

Uebertragungsdaempfung vs freq

0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1.0 1.10.0 1.2

-0.45

-0.40

-0.35

-0.30

-0.25

-0.20

-0.15

-0.10

-0.05

-0.50

0.00

freq, GHz

dB
(S

(2
,1

))
dB

(S
21

_l
um

pe
d)

Uebertragungsdaempfung vs freq im Durchlassbereich

1 2 3 4 50 6

-40

-30

-20

-10

-50

0

freq, GHz

dB
(S

(1
,1

))
dB

(S
11

_l
um

pe
d)

Returnloss vs freq

Lowpassfilter Chebyshev 0.05 dB / 1000 MHz
Ideal Microstrip Lines (No Discontinuities, No Loss, No Optimization)
Step 3

Eqn S21_lumped=Step2..S(2,1)

Eqn S11_lumped=Step2..S(1,1)

Lumped ideal

Microstrip (No Loss, No Optimization)
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Step 4: Sämtliche Discontinuitäten wie Leiterbreitensprünge (Steps), Bögen, Winkel, 
etc.werden eingefügt und wieder die Leitungslängen optimiert. 

Anschlussleitung
W aus "Linecalc"

50 Ohm

50 OhmC5L4

C3L2C1

Werte nach
Optimization

Werte der Goals wie Step 3a

SperrbereichDurchlassbereich Sperrbereich

L1 = 10.57
L2 = 14.04
L3 = 18.85

verlustfrei

Startwerte aus
Step 3a:

ev. Step vergroessern, damit
Optimization schneller ablaeuft

Var
Eqn

S-PARAMETERS

MSub

OPTIM

GOAL GOAL GOAL

MSTEPMSTEPMSTEP

MSTEP

GoalGoalGoal

Optim

MSUB

VAR

MSTEP MSTEP

MLINMLIN

S_Param

Term

Term

MLINMLIN MLIN

MLIN

MLIN

Step6Step5Step4

Step3Step2

OptimGoal3OptimGoal2OptimGoal1

Optim1

RO4350

VAR1

Step1

TL7TL6

SP1

Term1

Term2

TL2TL1 TL3

TL5

TL4

W2=3.4 mm
W1=12 mm
Subst="RO4350"

W2=0.3 mm
W1=12 mm
Subst="RO4350"

W2=0.3 mm
W1=12 mm
Subst="RO4350"

W2=0.3 mm
W1=12 mm
Subst="RO4350"

W2=0.3 mm
W1=12 mm
Subst="RO4350"

Indep1Max[1]=3 GHz
Indep1Min[1]=2 GHz
LimitWeight[1]=10
LimitMax[1]=-25
LimitMin[1]=
LimitType[1]="LessThan"
LimitName[1]="limit1"
IndepVar[1]="freq"
Weight=1
SimInstanceName="SP1"
Expr="db(S21)"

Indep1Max[1]=4 GHz
Indep1Min[1]=1 GHz
LimitWeight[1]=1
LimitMax[1]=
LimitMin[1]=-19
LimitType[1]="GreaterThan"
LimitName[1]="limit1"
IndepVar[1]="freq"
Weight=1
SimInstanceName="SP1"
Expr="db(S11)"

Indep1Max[1]=1 GHz
Indep1Min[1]=10 MHz
LimitWeight[1]=1
LimitMax[1]=-19
LimitMin[1]=
LimitType[1]="LessThan"
LimitName[1]="limit1"
IndepVar[1]="freq"
Weight=1
SimInstanceName="SP1"
Expr="db(S11)"SaveAllTrials=no

EnableCockpit=yes
SaveCurrentEF=no
UseAllGoals=yes

UseAllOptVars=yes
SaveAllIterations=no
SaveNominal=no
UpdateDataset=yes
SaveOptimVars=no
SaveGoals=yes
SaveSolns=yes
Seed=
SetBestValues=yes
NormalizeGoals=yes
FinalAnalysis="None"
StatusLevel=4
DesiredError=0.0
MaxIters=50
OptimType=Random

Rough=0 um
TanD=0
T=35 um
Hu=1.0e+033 mm
Cond=1.0E+50
Mur=1
Er=3.66
H=60 mil

L3=17.6401 {o}
L2=13.2601 {o}
L1=10.0288 {o}

Subst="RO4350"
W1=12 mm
W2=3.4 mm

L=10.0 mm
W=3.4 mm
Subst="RO4350"

L=L1 mm
W=12.0 mm
Subst="RO4350"

L=L2 mm
W=0.3 mm
Subst="RO4350"

Step=2 MHz
Stop=6 GHz
Start=10 MHz

Z=50 Ohm
Num=1

Z=50 Ohm
Num=2

Subst="RO4350"
W=12.0 mmW=3.4 mm

L=10.0 mm

Subst="RO4350" Subst="RO4350"
W=0.3 mm
L=L2 mmL=L1 mm L=L3 mm

W=12.0 mm
Subst="RO4350"
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Step 5: Die Kupferverluste (Cond), die Dielektrikumsverluste (tanD) und die Kupfer-
Oberflächenrauhigkeit (Rough) werden auf reale Werte gesetzt. 
Cond = 5.8e7,  tanD = 0.0037,  Rough = 2.4 um 
  
Falls notwendig, sind die Leitungslängen nochmals zu optimieren, dabei ist zu 
beachten, dass mit steigender Frequenz auch die Verluste (Dämpfung im 
Durchlassbereich) zunimmt und die Goals für die Optimierung entsprechend 
angepasst werden müssen. 
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Step 6: Ist die Simulation und Optimierung zur Zufriedenheit abgeschlossen, kann das Layout 
erstellt werden. Bei einfachen Schaltungen und Strukturen kann dies automatisch 
generiert werden (Layout > Generate/Update Layout, Starting Component: P1).  
 

 

 

Jetzt kann eine EM-Simulation (Momentum) durchgeführt werden. Dazu muss zuerst das Substrat 
definiert werden und das EM-Simulations-Setup eingestellt werden. 

 

Im Layout Substrateditor starten:  
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In diesem Fenster können bei komplizierten Substraten die Werte aus der „MSub“-Anweisung im Schema 
geladen werden (File>Import>Substrate from Schematic). In vorliegendem Beispiel wird das Substrat 
manuell definiert. Detailinformationen zu den einzelnen Parameter und Verfahren sind im Help zu finden. 
 
Mit Maus Groundplane selektieren. Parameter unverändert übernehmen. 
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Dielektrikum anwählen. Dicke angeben. Material editieren. 

 

 
Neu definiertes Material anwählen: 
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Interface anwählen. Parameter unverändert übernehmen: 

 
 
Layer „cond“ (Leiter) anwählen. Material definieren, Operation, Position und Dicke einstellen, Rauhigkeit 
definieren: 
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Damit ist die Substratdefinition abgeschlossen. 
 

Save Substrat . 

EM-Simulation Setup:  
 
Zusammenfassung und Simulatorauswahl: 
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Substratauswahl: 

 
 
Frequenzplan: 

 
Zum überprüfen der Simulationszeit Npts nur auf 2 einstellen. 
 
Eventuell Dataset-Name ändern: 
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Mesh-Eigenschaften einstellen: 

 
Für eine erste Kontrollsimulation ist ein grobes Mesh mit ca 20 Cells/Wavelength empfohlen. 
Die Parameter für die restlichen Felder (Options, Ports, Recources, Model/Symbol, Notes) können auf 
den Defaultwerten belassen werden. 
 

Start der Simulation:           
 

EM-Simulationen können je nach Rechner, Layoutstruktur und EM-Setup lange dauern. Eine 
Probesimulation mit grobem Mesh (20 Cells/Wavelaength) und wenigen Frequenzpunkten wird zur 
Abschätzung der Simulationszeit empfohlen. 

 

Simulationszeit für obige Schaltung mit max. 25 Frequenzpunkten, 10 MHz bis 6 GHz,  
35 Cell/Wavelength @ 6 GHz, Rechner Win7, 64 Bit, 8GB RAM, CPU Intel i5 750@2.67GHz: 

ca 4 Minuten.  

 

Simulationszeit für obige Schaltung mit max. 25 Frequenzpunkten, 10 MHz bis 6 GHz,  
60 Cell/Wavelength @ 6 GHz, Rechner Win7, 64 Bit, 8GB RAM, CPU Intel i5 750@2.67GHz: 

ca 20 Minuten.  
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Returnloss vs freq

Lowpassfilter Chebyshev 0.05 dB / 1000 MHz
Real Microstrip Lines
Step 6  All Discontinuities and Losses

Eqn S21_lumped=Step2..S(2,1)

Eqn S11_lumped=Step2..S(1,1)

Lumped ideal

Microstrip Schematic (All Discontinuities and Losses)

Momentum Simulation from Layout

Eqn S21_Mom=Step5_MomUW_a..S(2,1)

Eqn S11_Mom=Step5_MomUW_a..S(1,1)

 

 

Das Layout mit Beschriftung, Vermassung und PCB-Umriss ergänzen und Gerberfiles für 
Printherstellung erstellen.  

• Zwei neue Layer („mechanical“ und „label“) erstellen.  
Siehe „Student Quick Reference Guide“, Part 2,  
9.4 Erstellung des Gerber-Files für die Printherstellung in unserem Labor 

• PCB-Umriss mit Polylinie auf Layer „mechanical:drawing“ zeichnen 

• Kommentar und Vermassung ausserhalb PCB, mit Insert>Text oder  auf Layer „text:drawing“, 
Texthöhe min. 1.5 mm 

• PCB-Beschriftung auf Layer „label.drawing“: Component-Palette: Block Text Fonts > sans, 
Texthöhe min. 2.5 mm 

• Hintergrund für PCB-Beschriftung, Rectangle auf Layer „label.drawing“ zeichnen 

• Erstellung des Gerber Files für die Printherstellung siehe  
„Student Quick Reference Guide“, Part 2,  
9.4 Erstellung des Gerber-Files für die Printherstellung in unserem Labor. 
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Weitere Dokumente 

Für die vorliegenden Übungen sind folgende Dokumente hilfreich: 

1. „Student Quick Reference Guide“, Part 1 und Part 2 

2. Advanced Design System Quick Start”: adstour.pdf 

 

Alle Dokumente sind auf Moodle abgelegt. 


